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Presentation of PSPP program

PSPP is a program for statistical analysis of sampled data. It is a meant to be free 
replacement for the proprietary program SPSS. Therefore, it is a System for statistical 
analysis and data management. It reads a syntax file and a data file, analyzes the data, and 
writes the results to a listing file or to standard output. The language accepted by PSPP is similar 
to those accepted by SPSS statistical products. 

The current version of PSPP, 0.7.6-g26ff6f, is woefully incomplete in terms of its statistical 
procedure support. PSPP is a work in progress and its development is ongoing. It already 
supports a large subset of SPSS's syntax. PSPP can take data from SPSS files and use 
them to generate tabulated reports and plots of distributions and trends, descriptive 
statistics, and conduct complex statistical analyses. 

At your option, PSPP will produce statistical reports in ASCII, PostScript, PDF, HTML, 
SVG, or OpenDocument formats. PSPP development is ongoing. Its statistical procedure 
support is currently limited, but growing.  

PSPP provides a user interface that makes statistical analysis more intuitive for all levels 
of users. Simple menus and dialog box selections make it possible to perform complex 
analyses without typing many lines of command syntax. 

The built-in PSPP Data Editor offers a simple and efficient spreadsheet-like utility for 
entering data and browsing the working data file. You can handle the output with greater 
flexibility by saving it into other file formats such as html and doc formats. 

The main PSPP web site is : <http://www.gnu.org/software/pspp/>. However, new 
versions are available for download on <http://pspp.awardspace.com/> and the last 
version is available since March 13, 2011. The manual can be accessed on < 
http://sunet.dl.sourceforge.net/project/pspp4windows/pspp-master.pdf>.
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1. Windows in PSPP

There are 3 different types of windows that you will see in PSPP:

1. 1. Data Editor Window

This window displays the contents of the data file. You may create new data files, or 
modify existing ones with the Data Editor. The Data Editor window opens automatically 
when you start an PSPP session.

1.1.1. Variables sub-window of the Editor window

1.2. Viewer window
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The Viewer window displays the statistical results and tables from the analysis you 
performed (e.g., descriptive statistics, correlations). A Viewer window opens 
automatically when you run a procedure that generates output. In the Viewer windows, 
you can edit and copy your results.

1.3. Syntax Editor Window

You can paste your dialog box choices into a Syntax Editor window, where your 
selections appear in the form of command syntax. You can then edit the command syntax 
to utilize special features of PSPP not available through dialog boxes. 

You can open up a Syntax Editor window and enter PSPP commands and execute the job. 
You can save these commands in a file for use in subsequent PSPP sessions.
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2. Menus in PSPP

Many of the tasks you may want to perform with PSPP start with menu selections. Each 
window in PSPP has its own menu bar with menu selections appropriate for that window 
type. The Data Editor window, for example, has the following menu with its associated 
toolbar:
Most menus are common for all windows and some are found in certain types of 
windows.

2.1. Common menus

File

Use the File menu to create a new PSPP system file, open an existing system file, read in 
spreadsheet or database files created by other software programs such as PSPP.

It can be used to read in an external ASCII data file from the Data Editor; create a 
command file, retrieve an already created PSPP command file into the Syntax Editor; 
open, and save output files from the Viewer.
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Edit

Use the Edit menu to cut, copy, and paste data 
values from the Data Editor; modify or copy text 
from the Viewer or Syntax Editor; etc. In the Data 
editor, this menu can be used to insert cases or 
variables.

View

Use the View menu to turn toolbars and the status 
bar on and off, and turn grid lines on and off from 
all window types; and control the display of value 
labels and data values in the Data Editor.

Analyze

This menu is selected for various statistical procedures such as tabulation, 
crosstabulation, correlation, linear regression, factor analysis, etc.
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Utilities
Use the Utilities menu to display information about variables in the working data file.

Help
The Help menu is not fully operational. It should open the reference manual which 
contains information on how to use the many features of PSPP. Context sensitive help is 
not yet available through the dialog boxes although the icon is there.

2.2. Data Editor specific menus

Data

Use the Data menu to make global changes to 
PSPP data files, such as transposing variables and 
cases or creating subsets of cases for analysis. 
These changes are only temporary and do not 
affect the permanent file unless you save the file 
with the changes.

Transform

Use the Transform menu to make changes to selected variables in the data file and to 
compute new variables based on the values of existing ones. These changes are 
temporary and do not affect the permanent file unless you save the file with changes.
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2.3. Syntax Editor specific menu

Run

Use the Run menu to run the selected 
commands.

Toolbars in PSPP

The Data Editor Viewer window has a toolbar that provides quick and easy access to 
common tasks. Tool Tips provide a brief description of each tool when you put the mouse 
pointer on the tool. For example, the toolbar with Insert Variable shows the following 
tool tip (create a new variable at the current position) when the mouse pointer is put on 
the icon:

All these tasks are also available under diverse elements of the menu (Edit, Data, etc.).

Status Bar in PSPP for Windows

A status bar at the bottom right of the PSPP application window indicates the current 
status of the PSPP session. The status bar provides information such as command status, 
filter status, weight status, and split file status. 



11

3. Preparing Data for Analysis

3.1. Organizing Data for Analysis

Suppose you have three remittance values collected for a group of 10 migrants (5 males, 
and 5 females) during a limited duration of time (18 mounts, value registered at the end 
of each semester for that semester). Each migrant was assigned an identification number. 
The information for each migrant you have is an identification number, gender of each 
migrant, and value for remittance one, remittance two, and remittance three (the full data 
set is displayed toward the end of this section for you to view). Your first task is to 
present the data in a form acceptable to PSPP for processing.
PSPP uses data organized in rows and columns. Cases are represented in rows and 
variables are represented in columns.

Variable
 •

Name Rem1 Rem2 rem3
Mig1 20 23 24 •Case
Mig2 21 26 28

A case contains information for one unit of analysis (e.g., a person, a country, a region). 
Variables are information collected for each case, such as name, sex, age, income,
country of birth, educational level. In the above chart, there are two cases and four 
variables.

Attributes of Variables

In PSPP, each variable has a number of attributes, including the name, Type, Width, 
Decimals, Labels, Values, Decimals, Label, Values, Missing, Columns, Align, Measure.  

Name: it is an identifier, up to 64 bytes long. Each variable must have a different name
less than eight characters of variable names are recommended. They must begin with a 
letter, although the remaining characters can be any letter, any digit, a period, or the 
symbols (@, #, _, or $). Variable names cannot end with a period ‘.’ because such an 
identifier will be misinterpreted when it is the final token on a line. The ‘.’ will be 
considered mistakenly as indicating end-of-command. Variable names that end with an 
underscore ‘_’should be avoided. Some system variable names begin with ‘$’, but user-
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defined variables' names may not begin with ‘$’. Blanks and special characters such as 
&, !, ?, ', and * cannot be used in a variable name. Variable names are not case sensitive. 
Each variable name must be unique; duplication is not allowed.

Type: most variables are generally numeric (e.g., 12, 93.23) or character / string /
alphanumeric (e.g., F, f, Ousmane). Only the first 16 digits are correct. The maximum 
number of decimal positions depends on the number of digits you have before the 
decimal point because the total valid digits for the numeric variable is 16. String variables 
with a defined width of eight or fewer characters are short strings; more than eight 
characters are long strings. Short string variables can be used in many PSPP procedures. 

You may leave a blank for any missing numeric values or enter a user-define missing 
(e.g., 9, 99, 999) value. However, for string values a blank is considered a valid value. 
You may choose to enter a user-defined missing (e.g., x, xxx, na) value for missing short
string variables, but long string variables cannot have user-missing values.
Following the conventions above, let us assign names for the variables in our data set: id, 
sex, Rem1, Rem2, and Rem3. 

Once the variables are named according to PSPP conventions, it is a good practice to 
prepare a code book with details of the data layout. Following is a code book for the data 
in discussion. Note that this step is to present your data in an organized fashion. It is not 
mandatory for data analysis. A code book becomes especially handy when dealing with 
large number of variables. A short sample data, like the following, may not need a code
book, but it is included for illustration.

Name Type Width Label Columns
id 8 Numeric identification no. 2 
sex 8 String migrant gender (f, m) 1 
Rem1 8 Numeric Remittance value 1st sem. 2 
Rem2 8 Numeric Remittance value 2nd sem. 2 
Rem3 8 Numeric Remittance value 3rd sem. 2 

In the above code book, width indicates the length of a variable measured in digits or 
characters. For example, the value for variable id takes a maximum of two fields since 
the highest identification number in our example is going to be 10. The value for variable 
sex takes a maximum of one field, and so on. Columns affect only the display of values 
in the Data Editor. Changing the column width does not change the defined width of a 
variable type specifies the data type (numeric, comma, dot, scientific notation, date, 
dollar, custom currency or string). In our example, sex is the only string variable coded as 
f for female, m for male.
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4. Data Entry

The next issue is entering your data into the computer. There are several options. You 
may create a data file using one of your favorite text editors, word processing packages 
(e.g., MS-Word) or a spreadsheet (e.g., Excel) and read it directly into PSPP for 
Windows. Files created using word processing software or a spreadsheet should be saved 
in text format (.txt) before trying to read them into a PSPP session. 

Finally, you may enter the data directly into the spreadsheet-like Data Editor of PSPP. In 
this document we are going to examine two of the above data entry methods: using a text 
editor/word, and using the Data Editor of PSPP.

4.1. Using an Editor/Word Processor to Enter Data

Let us first look into the steps for using a text editor or word processor for entering data. 
Note that if you have a data set with a limited number of variables, you may want to use 
the PSPP Data Editor to enter your data. However, this example is for illustration 
purposes.
Open up your editor session, or word session, and enter the variable values into 
appropriate columns as outlined in the code book. If you are using a word processor, 
make sure to save your data in text format (txt). Your completed data file will appear as 
follows.

01f838591
02f657268
03f909490
04f878082
05f788680
06m607464
07m889692

Save the data as a text file named, Remit.txt.
Notice that in the above data layout no blank space is left after each variable. We will 
discuss later the case of blank space left between variables as specified in the code book. 
It is optional whether to leave a space between variable values. 

Whichever style (format) you choose, as long as you convey the format correctly to 
PSPP, it should not have any impact on the analysis. 
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4.2. Creating a Command file to read in your data

In many instances, you may have an external ASCII data file made available to you for 
analysis, just like the data, remit.txt, we discussed earlier. In such a situation, you do not 
have to enter your data again into the Data Editor. You can direct PSPP to read the file 
from the PSPP Syntax Editor window.2

Suppose you want to read the file, remit.txt, into PSPP from a Syntax Editor window 
and create a system file. Creating a command file is a faster way to define your variables, 
especially if you have a large number of variables. You may create a command file using 
your favorite editor or word processor and then read it into a Syntax Editor window or 
open a Syntax Editor Window and type in the command lines.

To read your already created command file into a Syntax Editor window Select File • 
Open • Syntax... Choose the syntax file (with .sps extension) you want to read and 
click Open. In the following example we are opening a new Syntax Editor window.
Select File • New • Syntax. When the Syntax Editor window appears, type:

GET DATA /TYPE=TXT /FILE='C:\PSPP\Remit.txt'/ARRANGEMENT=FIXED 
/FIRSTCASE=1 /VARIABLES= id 0-1 F sex 2 A rem1 3-4 F rem2 5-6 F rem3 7-
8 F.

Alternatively, to save the new file immediately in PSPP data format, you type: 

GET DATA /TYPE=TXT /FILE='C:\PSPP\Remit.txt'/ARRANGEMENT=FIXED 
/FIRSTCASE=1 /VARIABLES= id 0-1 F sex 2 A rem1 3-4 F rem2 5-6 F rem3 7-
8 F.
EXECUTE.
SAVE /OUTFILE='C:\PSPP\remit.sav'.

Click and drag with your mouse to highlight the lines entered, then click Run and choose 
selection.

This supposes that the name and location of the file is: C:\PSPP\Remit.txt
If different, you change.

The command file will read the specified variable values from the data file, Remit.txt, on 
C:\PSPP, and create a system file, remit.sav, on C:\PSPP. Make sure you specify the 
pathname; appropriately indicating the location of the external data file and where the 
newly created file is to be written. However, you do not have to save a system file to do 
the analysis. This means the last line is optional for data analysis. Every time you run the 
above lines, PSPP does create an active file stored in the computer's memory. However, 

  
2 You can also use the Menu à File à Import Delimited Text Data. If this end with a bug, use the Syntax 
Editor and create an appropriate command file.
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for large data sets, it will save processing time if you save it as a system file and access it 
for analysis.

In the above command lines, VARIABLES defines a raw data file by assigning names 
and formats to each variable in the file. They can be in fixed format (values for the same 
variable are always entered in the same location on the same record for each case) or in 
free format (values for consecutive variables are not in particular columns but are entered 
one after the other, separated by blanks or commas). In our example, we have the fixed 
format and used ARRANGEMENT=FIXED. 

FIRSTCASE=1 is the default if data starts from the first row. That is, in our example we 
did not have to use the FIRSTCASE=1 keyword, but it is included for the sake of 
illustration. The only string variable in the data is sex, which is identified with a A after 
the variable name and column location. The others are identified with an F as numeric 
variables.

4.3. Reading delimited data

In the case of blank space left after each variable. The syntax will be different. For 
example, you may choose to enter/save in texte (.TXT) format as following:

id sex rem1 rem2 rem3
01 f 83 85 91
02 f 65 72 68
03 f 90 94 90
04 f 87 80 82
05 f 78 86 80
06 m 60 74 64
07 m 88 96 92
08 m 84 79 82
09 m 90 87 93
10 m 76 73 70

In this case, when Syntax editor window appears, you type: 

GET DATA /TYPE=TXT /FILE='C:\PSPP\Remit2.txt' /DELIMITERS=' ' 
/FIRSTCASE=2

/VARIABLES=id F2
sex A1
rem1 F2
rem2 F2
rem3 F2.
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And if we want to save immediately the new PSPP data file, we add the commands as 
showed by these two following line.

EXECUTE.
SAVE /OUTFILE='C:\PSPP\Remit2.sav'.

Most databases and spreadsheet programs are able to read or save data in a delimited text 
format. Any character or sequence of characters may be used to separate the values, but 
the most common delimiters are the comma, tab, and colon. The vertical bar (also 
referred to as pipe) and space are also sometimes used. The data files with formats 
using delimiter-separated values can be read by PSPP. In this case, you adapt the syntax 
by indicating the appropriate delimitation.

You can also save the created command file into a Syntax Editor window Select File • 
Save... and save the syntax file (with .sps extension).

Using Text Import Wizard to Read Text Data3

Using Text Import Wizard is another way to direct PSPP to read an external ASCII data 
file. Suppose you want to read the file, remit.txt, into PSPP from Text Import Wizard.
Select File • Import delimited data, choose the data file remit.txt in your (C:\PSPP) 
drive and click Open and follow the Steps in the wizard to specify how the data should 
be read.
The data file is read into the PSPP. We can save the data file as remit.sav.

4.4. Using the PSPP Data Editor for entering data

Suppose you want to use the PSPP features for data entry. In that case, you enter data 
directly into the PSPP spreadsheet-like Data Editor. This is convenient if you have only a 
small number of variables. The first step is to enter the data into the Data Editor window 
by opening a PSPP session. You will define your variables, variable type (e.g., numeric, 
string), number of decimal places, and any other necessary attributes while you are 
entering the data. In this mode of data entry, you must define each variable in the Data 
Editor. You cannot define a group of variables (e.g., Q1 to Q10) using the Data Editor. 
To define a group of variables, without individually specifying them, you would use the 
Syntax window.

Let us start a PSPP session to enter the above data set. Start Windows and launch PSPP. 
This opens the PSPP Data Editor window (titled Untitled). The Data Editor window 
contains the menu bar, which you use to open files, choose statistical procedures, etc. 
When you start a PSPP session, the Data Editor window always opens first. You are 
ready to enter your data once the Data Editor window appears. The first step is to enter 
the variable names that will appear as the top row of the data file. When you start the 

  
3 This option is still experimenting bugs in the current version of PSPP (March 2011).
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session, the top row of the Data Editor window contains a dimmed var as the title of 
every column, indicating that no data are present. In our sample data set, discussed above, 
there are five variables named earlier as id, sex, remit1, remit2, and remit3. Let us now 
enter these variable names into the Data Editor.
To define the variables, click on the Variable View tag at the lower left corner of the 
Data Editor window and:

• Type in the variable name, id, at the first row under the column Name.
• Press the Tab key to fill-in the variable's attributes with default settings.

PSPP considers all variables as numeric variables by default. Since id is a numeric 
variable you do not have to redefine the variable type for id. However, you may want to 
change the current format for decimal places. Enter 0 for Decimals.
Now let us define the second variable, sex.

• Type in the variable name, sex, at the second row under the column Name.
• Press the Tab key to fill-in the variable's attributes with default settings.
• To modify the variable type, click on the grey vertical rectangle icon in the Type 
column.
• Select String by clicking on the circle to the left.

Define the remaining three numeric variables, rem1, rem2, and rem3, the same way the 
variable id was defined. Once you have finished, the Variable View screen should look 
like:

Click on the Data View tag. Now enter the data pressing [Tab] or the right arrow key 
after each entry. After entering the last variable value for case number one use the arrow 
key to move the cursor to the beginning of the next line. Continue the process until all the 
data are entered.
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4.5. Saving  PSPP Data

After you have entered/read the data into the Data Editor, save it onto C:\PSPP or the 
flash drive or any other location. 
• Select Save... or Save As... from the File menu. A dialog box appears:
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In the box below File Name type C:\PSPP\remit.sav.
Click OK
The data will be saved as a PSPP format file which is readable by PSPP. Note that the 
data file, remit.txt, you saved earlier and the file, remit.sav, you saved now are in 
different formats.

4.7. Read ASCII data and save as a PSPP data file

The purpose of this example is to illustrate:                      
1.  Data input from the data file Personnel.dat via the DATA LIST command.                                                
2.  Saving data & a data dictionary (includes all labels and missing value codes) as an 

SPSS data file via the SAVE OUTFILE command. Note that you can also create a PSPP 
data file by selecting Save from the File menu in the SPSS Data Editor.                                                      
Personnel.dat - ASCII data file à Personnel.sav - PSPP data file created 
Note the location of both data files is the PSPP folder in the C: drive. 
To run these syntax commands select Run à All from the Run menu in the PSPP Syntax 
Editor.                                                

data list file='C:\PSPP\Personnel.dat' records=2 
/1 name 1-24(A) employid 26-30
/2 yrhired 3-4 age 6-7 race 9 sex 11 locatn82 13 dept82 15 
jobcat 17 promo82 19 salary82 21-25 raise82 27-31 
eeo82 33-33.

variable labels
name     "Employee's Name"
employid "Employee's Badge Number"
yrhired  "Year of First Hiring"
age      "Employee's Age in 1980"
race     "Employee's Race"
sex      "Employee's Sex"
locatn82 "City Where Employed"
dept82   "Department Code in 1982"
jobcat   "Job Category"
promo82  "Was Emp Promoted in 1982?"
salary82 "Yearly Salary in 1982"
raise82  "Increase in Salary over 1981".

value labels
race 1 'Black' 2 'A.Indian' 3 'Oriental' 4 'Latino'

5 'White'
/sex 1 'Male' 2 'Female'
/locatn82 0 'Not Employed' 1 'Chicago' 5 'St. Louis'
/dept82 0 'Not Employed' 1 'Administrative' 2 'Project Directors'

3 'Chicago Operations' 4 'St. Louis Operations'
/jobcat 1 'Officials & Managers' 2 'Professionals'

3 'Technicians' 4 'Office and Clerical' 5 'Craftsmen'
8 'Service Workers'

/promo82 0 'No' 1 'Yes' 9 'Not Employed'.
missing values

yrhired to dept82 salary82 (0)/ promo82 (9)/raise82 (-999).

execute.
save outfile='C:\PSPP\Personnel.sav'   /compressed.
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5. Descriptive Data Analysis

Suppose that you have the data set, remit.sav, still displayed on the screen. If not, select 
PSPP Data Editor à Open à C:\PSPP\remit3.sav à Open
Here, for the data processing, let us use an extended file containing data for 40 cases.

The next step is to run some basic statistical analysis with the data you entered. The 
commands you use to perform statistical analysis are developed by simply pointing and 
clicking the mouse to appropriate menu options. This frees you from typing in your 
command lines.

However, you may paste the command selections you made to a Syntax Editor window. 
The command lines you paste to the Syntax Editor window may be edited and used for 
subsequent analysis, or saved for later use. Use the Paste pushbutton to paste your dialog 
box selections into a Syntax Editor window. If you don't have an open Syntax Editor 
window, one opens automatically the first time you paste from a dialog box. Click the 
Paste button only if you want to view the command lines you generated. Once you click 
the Paste pushbutton the dialog selections are pasted to the Syntax Editor window, and 
this window becomes active. To execute the pasted command lines, highlight them and 
click run à Selection or Run à All if this is the case. You can always get back to the 
Data Editor window by selecting remit3.sav-PSPP Data Editor from the Window 
menu.


